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LIMITED WAIUtA.\lY ON MEDIA AND REPlACEMENT 

If you discover physical defects in the manuals distributed with an Apple product or in the media on which a software 
product is distributed, Apple will replace the media or manuals at no charge to you, provided you return the item to 
be replaced with proof of purchase to Apple or an authorized Apple dealer during the 9O-day period after you 
purchased the software. In addition, Apple will replace damaged software niedia and manuals for as long as the 
software product is included in Apple's Media Exchange Program. While not an upgrade or updale method, this 
program offers additional protection for up to two years or more from the date of your original purchase. See your 
authorized Apple dealer for program coverage and details. In some countries the replacement period may be 
different; check with your authorized Apple dealer. 

AU. IMPLIED WARIWiTIES ON THE MEDIA AND MANUAlS, INCWDING IMPIJED WARJlAI\,'11ES OF 
1WlCllA.1\'TABIUJ'Y AND mNESS FOR A p.uncm.u PURPOSE, ARE UMlTED IN DtlIlAnON TO l\'Il\'ETY 
(90) DAYS FROM DIE DATI OF DIE ORIGINAL RETAIL PIJJlCHASE OF nus PROOOCl'. 

Even though Apple has tested the software and reviewed the documentation, APPLE MAlES NO WAIUlA.\'TY OR 
REPRISE.\'TATIOS, mHER EXPRESS OR 1MPIlED, WlIlI RESPECT TO SOFTWARE, rrs QUAIlfY, 
PERFOR.\lA!~CE, MERCHA.\'TABlLlTY, OR Fm'ESS FOR A PAmClJl.U PURPOSE. AS A RES1.J1.T, nus 
SOFTWARE IS SOU> MAS IS: AND YOU, THE PURCHASER, ARE ASSUMlXG THE L\'TIRI RISK AS TO ITS 
QUAIlfY A..'iD PERFOR.\IA.'~CE. 

IN NO EVE!\, WIll APPlE BE IlABLE FOR DIRICI', INDIRECI', SPEaAI., 1S0·DE.\"TAL. OR 
CONSEQUL'11AL DAMAGES RESULTING FROM Ao\'Y DEFEer IN THE SOFTWARE OR rrs DOCUME.\"TATIOS, 
even if advised of the pOSSibility of such damages. In particular, Apple shall have no liability for any programs or data 
stored in or used with Apple products, including the costs of recovering such programs or data. 

THE WA.RRA.'lY AND RIMEDIF5 SET FOml ABOVE ARE EXOlJSIVE A..~D IS lIEU OF AU. OTHERS, ORAL 
OR WlUTTE.'i, EXPRESS OR IMPUED. No Apple dealer, agent, or employee is authorized to make any 
modification, extension, or addition to this warranty. 

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential 
damages, so the above limitation or exclusion may not apply to you. This warranty gives you specific legal rights, and 
you may also have other rights which vary from state to state. 

WAR.'iL'iG 

This equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in accordance 
with the instructions in this manual, may cause interference to radio communications. It has been tested and found to 
comply with the limits for a Class A computing device, in accordance with the specifications in Subpan J of Pan 15 of 
FCC rules. These specifications are designed to provide reasonable protection against such interference when the 
eqUipment is operated in a commercial environment Operation of this equipment in a residential area is likely to 
cause interference, in which case the user, at the user's own expense, will be required to take whatever measures 
may be necessary to correct the interference. 

DOC Class A Compliance This digital apparatus does not exceed the Class A limits for radio noise emissions from 
digital apparatus set out in the radio interference regulations of the Canadian· Department of Communications. 

Observation des normes-Classe A I.e pr!sent apparet1 num&ique n'Cme! pas de bruits radi~leCtriques depassanl 
Ies Iimites applicabJes aux appareils nu~riques de la Classe A prescrites dans les r~glements sur Ie brouillage 
radi~leCtrique !dictes par Ie Minist~re des Communications du Canada. 
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Radio and television interference 

True equipment described in this manual generates, uses, and radiates radio
frequency energy. 1£ it is not installed and used properly-that is, in strict 
accordance with the instructions in this manual-it may cause interference with 
radio communication. 

This equipment has been tested and found to comply with the limits for a Class A 
computing device in accordance with the specifications in Su bpan J of Pan 15 of 
FCC rules. These specifications are designed to provide reasonable protection 
against such interference when the equipment is operated in a commercial 
environment. 

Operation of this equipment in a residential area is likely to cause interference, in 
which case the user, at the user's own expense, will be required to take whatever 
measures may be necessary to correct the interference. 

D. Important This product was tested for FCC compliance under conditions that included the 
use of shielded cables and connectors between system components according to 
the standards for RG-62 cables. It is imponanl that you use coaxial cables and 
connectors to reduce the possibility of causing interference to radios, television sets, 
and other electronic devices. For Apple peripheral devices, you can obtain the 
proper shielded cables from your authorized Appie dealer. For non-Apple:! 
peripheral devices, contact the manufacturer or dealer for assistance. £:::, 
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p R E F A c E 

About This Guide 

T HIS um, GUIDE TELI5 YOU HOW TO INSTAlL AND USE 1llE MA(J)I'I'" 

application. MacDFT enables your Macintoshat> II computer to emulate the 

3270 family of IBM tenninals. This guide also explains how to install the 

Appleat> Coax/Twinax card. 

xv 



What you need to know 

To use this manual successfully, you should be familiar with the operation of 
your Macintosh II computer. For example, you should feel comfortable using 
the mouse and desktop. If you have just received your Macintosh II 
equipment and have never used a Macintosh before, check your owner's guide 
for information on setting up and using the Macintosh. 

6. Important When you're setting up your new Macintosh equipment, you can save 
yourself a step by imta1ling the Coax/J'winax card at the same time that you 
install the video card. Follow the video card installation diredions in your 
owner's guide to install the Coax/I'winax card. Installation procedures for the 
Coax/rwinax card are also included in Olapter 2 of this guide. t:::. 

xvi Preface: About this guide 

What's covered in this guide 

Here's a description of what you'lIleam in each chapter. Note that the 
chapters should be read in consecutive order, since each chapter builds on 
concepts presented in the preceding chapter. 

• Chapter 1, -Introducing MacDFf,· describes the features of MacDFf and 
tells you what you'll need to get started. 

• Chapter 2, -Setting Up MacDFf, • explains how to install your 
Coaxffwinax card, attach the coaxial cable, and install the MacDFf 
software. 

• Chapter 3, -Configuring MacDFf,· explains how to configure MacDFf 
and save your configuration choices in a MacDFT configuration 
document. 

• Chapter 4, ·Communicating With a Host,· discusses how to launch and 
operate the MacDFf application. 

• Chapter 5, ·Using the Keyboard and Keypad,· addresses how to 
customize your keyboard and keypad fa terminal emulation sessions. 

• Chapter 6, -rransferring Files,· describes fde transfer between the 
Macintosh and the IBM host. 



The appendixes contain valuable information: 

• Appendix A, -Reading the Status Line,· describes some of the status line 
messages that you'll see when using MacDFT. 

• Appendix B, -MacDFT Error Messages,· describes error messages 
generated by MacDFT and suggests possible solutions to problems. 

• Appendix C, -Supported Environrnent,·lists the terminals that MacDFT 
emulates, hosts connections, and other features supported by MacDFT. 

The glossary at the end of this manual includes Macintosh-related terms and 
other computer terms that you might find helpful. New tenns are presented 
in boldface type and are usually defined in the text. All terms that appear in 
boldface are defined in the Glossary. 

Tenninology and conventions 

This section explains terminology used in this manual and shows some of the 
conventions used to highlight information. 

Macintosh II 

The term Macintosh II is used to refer to all Macintosh II computers, 
including the Macintosh IIx and the Macintosh IIex computers. 

3270 

The term 3270 is used to refer to the family of IBM Information Display 
System terminals. 

3X74 
The number 3X74 refers to IBM's 3174 or 3274 control units. 

Special messages 

Look for these special cues throughout the guide. 

• Note: A note like this presents additional information or interesting 
Sidelights. 

Preface: About This Guide xvii 



D. Important Be sure to read everything that's labeled with the word Important. 6. 

.A Warning Warnings like this indicate poteltially serious problems. & 

xviii Preface: About this guide 

A special typeface indicates text that you should type: 

It looks like this. 

Related manuals 
For information about how to use your Macintosh computer, refer to the 
following manuals, which came with your Macintosh computer: 

• Mactntosh II ()ume;s Guide: This manual explains how to set up and use 
your Macintosh II. 

• Macintosh Utilities User's Guide: This manual describes how to initialize, 
or format, your hard disk. The Madntosh New Features update booklet 
explains how to install the system software. 

You might want to refer to the manuals that came with your host network 
equipment. In addition, many books are available that explain various aspects 
of 3270 communication. For example, see the following IBM documentation: 

• IBM 3270 Information Display System Information (GA27-2739-21): 
This book describes various components of IBM's 3270 Information 
Display Systems, including terminals, personal computers, printers, and 
control units. 

• IBM 3270 Information Display System: 3274 Control Unit Description 
and Programmer's Guide (GA23-0061): This guide provides system-level 
reference material and describes programming characteristics of 3274 
control units and attached terminals. 
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Introducing MacDFf 

T HE MACDFI'"' APPUanON AlLOWS YOUR APPtI" M'(Th1'OSH~ n COMPL'TER 

to emulate an IBM 3270 Information Display System terminal. Terminal 

emulation means that the Macintosh appears to the IBM host as a 3270 

display terminal, without any apparent operational differences between the 

Macintosh and an actual 3270 terminal. When you run MacDFT on a 

Macintosh attached to an IBM host, the Macintosh can emulate the 

characteristics of an mM 3270 Information Display System. This 

chapter describes the features of MacDFT and tells you what you need to 

get started. 



Upgrading the memory for 
the CoaxiTwinax card 

The Apple Coax/Twinax Card 

To use MacDfT, you must install the Apple Coax!fwinax card in your 
Macintosh II computer. The card plugs into one of the Nubus slots in the 
Macintosh II and connects to an IBM host via a 3X74 control unit using 
standard RG-62AU cooxial cable. 

The Coax!fwinax card is an intelligent communication card based on the 
Macintosh Coprocessor PlatformTII • With its own microprocessors, operating 
system, and memory, this card operates independently of the memory and 
processing ability of the Macintosh computer. Because all the 
communication processing is done on the Coax!fwinax card, communication 
between the Macintosh and the host does nOl affect the speed of 
Macintosh applications. Chapter 2 tells how to install your interface card and 
connect your coaxial cable. 

You can upgrade the memory on your Coax!fwinax card by adding the 
Macintosh Coprocessor Platform card expansion kit. The standard card is 
equipped with 512K (kilobytes) of memory; using the MaCintosh II 
Macintosh Coprocessor Platform card expansion kit, you can increase the 
memory on your communication card to 1 MB (megabyte). The Macintosh 
Coprocessor Platform card expansion kit is available through authorized 
Apple dealers, who can install it on the Coax!fwinax card. 

<- Note: MacDfT 1.0 does nOl require additional memory on the Apple 
Coax/rwinax card. 

About MacDFT 

MacDfT enables you to have terminal emulation with Macintosh user 
interface enhancements such as pull-down menus and windows. You can 
share data between the Macintosh and the IBM host computer either by 
copying and pasting data from applicatiOns, or by transferring files. MacDfT 
functions under MultifinderTIi • 

2 Chapter 1: introducing MacDfT 
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Using MacDFT, your Macintosh can emulate an IBM 3270 Information 
Display System terminal and communicate with an IBM host through a 3174 
or 3774 control unit. The control unit links the tenninal and the host. The 
control unit and host can be configured in several ways. The configuration of 
the control unit and ~t determines the type of terminal your Macintosh II 
emulates. Figure 1-1 shows two typical configurations for Macintosh 
connections to a local and remote host . 

• FIpft 1-1 The Macintosh connected to a control unit and a host 

[j]==-

II 
o 

H06t 37X5 front-end processor 3X74 control unit Macintosh II 

Local conlguradon with MacDIT IDftwate 

[j]-=-

II 

H06t 3X74 control unit Macintosh II 

QJaxial cabling 

Otannel connection ==== 
Remote connection -z... 

Chapter 1: Introducing MacDfT 3 



A tenninal, or computer emulating a tenninal, can communicate with an IBM 
host that supports either a single session or multiple sessions. The control 
unit port, the configuration of the host, and the configuration of the 
MacDfT software detennine which communication mode your Macintosh 
can use. With MacDfT version 1.0 software, you can connect your Macintosh 
to a 3270 network and emulate a single 3270 tenninal session. Future versions 
of MacDfT will support multiple sessions running concurrently. 

What you need to get started 
You can use MacDfT on any of the Macintosh II family of computers, with 
the standard or extended keyboard. 

D" Important Your Macintosh II must have system software version 6.0.3 or a later version. L. 

To use MacDfT, you must have the following: 

• the MacDFJ 1.0disk 

• an Apple CoaxIfwinax card 

• a coaxial cable connected to a 3174 or 3274 control unit 

On the IBM host, you need the appropriate file transfer software: 

Software Part number 

MVS/TSO operating environment 5665-311 

VM/SP host operating environment 5664-281 

Appendix C lists the IBM host and communications equipment with which 
MacDFT works. 

4 Chapter 1: Introducing MacDFT 
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Setting Up MacDFf 

T HIS CHAmR EXPIA'" lKlW TO INSTAll 1lIE COAX/fWINAX CAJU) A.'" 
MacDFT softv.'3re. If you have just received your new Macintosh II, you 

must first set it up before you install MacDFT. You should install your 

CoaxfI'winax card at the same time that you install your video card. See your 

Macintosh owner's guide for instructions on how to install the video card. If 

your Macintosh personal computer is already set up, you can skip to 

"Installing the Hardware for MacDFT,' where card installation is also 

covered. 

5 



What you need to install 
MacDFT 

Before you begin 
If you have just received your Macintosh II equipment and have never used a 
Macintosh before, check your Macintosh II owner's guide for information 
on setting up and using your new computer. You must know some of the 
basic information on how to use the Macintosh computer before installing 
and using MacDFT. 

After setting up your Macintosh, you might want to use the tutorial disk to 
learn about the Macintosh computer. Your owner's manual explains how to 
use the tutorial. Once you feel comfortable using the mouse and the 
desktop, you should initialize your hard disk and install the system software. 
Follow the instructions in the hard disk owner's guide. 

To install MacDfT, you should have an Apple Coax/rwinax card, this manual, 
and a disk labeled MacDFT 1.0, as shown in Figure 2-1. Your Management 
Information System (MIS) department should have provided an installed 
control unit with a coaxial cable attached. 

"Note: You'll also need a Phillips screwdriver to install your card. 

6 Chapter 2: Setting Up MacDIT 
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Unpacking the card 

Installing the card 

(. 
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• Figure 2·1 What you need to install MacDIT 

Installing the hardware for MacDFr 

This section tells you how to install your hardware, which means installing 
your card and attaching the coaxial cable. If you have already installed your 
Coax/Twinax card, skip ahead to the section called "Installing MacDIT 
Software." 

Keep the card in its protective, antistatic bag until you're ready to install it. 
When you take the card out of the bag, hold it by the edges, not by the 
components. Be sure not to touch the gold pins on the bottom edge of the 
card. 

Follow these steps to install the Coax/Twinax card. 

1. Turn off the power. 

Figure 2·2 shows the power switch on the back of the computer. 

Chapter 2: Setting Up MacDIT 7 



.& Warning Make sure that the power to all your computer equipment is turned off, but 
leave the power cords plugged into a grounded outlet. This keeps your 
computer system safely grounded. 

Check the power indicator light on the front of the computer to make sure 
the power is off. If the power has been on, wait at least five minutes before 
continuing, to allow the power supply case inside the computer to cool 
down . .t. 

• Figure 2-2 Make sure the power is off 

Powerswitch --------""t:~.1!.!~!!_==~ _____ ..J~ ___ 

8 Chapter 2: Setting Up MacDIT 

2. Remove the computer's lid. 

a Using a Phillips screwdriver, remove the security screw at the top 
center of the computer's rear panel. 

b Grasp the rear comers of the case, as shown in Figure 2-3. 

c. Press on the lid latches with your fingers while you lift up the back of 
the lid. 

d. When you feel the lid release, lift it off the case and put it aside. 
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• Figure 2·3 Rem:>ving the lid 

~ri~~ew----------------------, 

3. When the power supply case has cooled down, touch the metal 
part of It, as shown In Figure 2-4. 

Touching the metal part of the power supply case discharges any static 
electricity that may have buih up on your clothes or body. 

A Warning Remember, the power supply can get very hot in nonnal use. If the computer 
has been on, wait at least five minutes for the metal case to cool dov.'fl 
before you touch it .• 

Chapter 2: Setting Up MacDFT 9 



• Figure 2·4 Touching the power supply case 

o 

Power supply case--------4J-

]0 Chapter 2: Setting Up MacDFT 

o 

o 

4. Select an expansion slot and find the expansion cover shield 
that's directly behind it. 

The expansion slots are narrow plastic strips, as shown in Figure 2-5. You 
can install the CoaxfI'winax card in any slot. 

(0 Note: Install the card in a slot where the outside cables are least likely to 
interfere with other cables. 
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• Figure 2-5 The expansion slots and expansion cover shield 

Expansion _______________ + 
cover shield 

Pin -----------------ttt~!i.h:""'__ 

Guide----------------t--'="" 

Expansion slots---------~~__=_~~~to:ttjr~~~~~~~~ 

Video card -----------+If---
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S. Remove the expansion cover shield that's behind the expansion 
slot you intend to use. 

Lift up the shield until its free of the guide and pin. Save the shield; it 
protects the interior of your computer, and you will need to reinsert it if 
you take the card out of the slot later. 

.. Note: Attached to the end of the card is a shield that will replace the shield 
you just removed. It fits into the guide the same way that the expansion 
cover shield fits. 

6. Push out the plastic hole cover that lines up with the slot you 
plan to use. 

a. Grasp the cover, with your thumb inside the computer and your 
fingers outside. 

b. Push the cover out with your thumb and set it aside, as shown in 
Figure 2-6. 

• Figure 2·6 Removing the hole cover 

Hole cover ------------./ 

7. Insert the Coaxtrwinax card into the expansion slot 

12 Chapter 2: Setting Up MacDIT 

a. Pick up the card by the edges or the top comers. (Avoid touching the 
pins on the bottom of the card.) 
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b. The expansion cover shield on the back of the card attaches to the 
inside of the back panel in the same way as the shield you removed in 
step 5. Align the card so that the guide is through the lower slot in the 
shield, and the pin sticks up slightly through the hole at the top of the 
shield, as shown in Figure 2·7. 

• Figure 2·7 Aligning the card 

Pin in hole ----------~~~~~\\~It~~ffrtf~J~~ 

GUideinSIOl:==j~II'~ 
Connector aligned over slot 

c. Align the connector on the bottom of the card directly over the slot. 

d. Place one hand on the top of the card, directly over the connector area, 
and then push down firmly until the connector is fully seated. To see 
if the card is properly connected, lift it gently. If it resists and stays in 
place, it's connected. 

6 Important Don't force the card into place. If you meet a lot of resistance, pull the card 
out and try again. Don't wiggle the card from side to side when you insert it. 
Wiggling the card puts unnecessary stress on the card and slot. t::. 

14 



APPLE CONFIDENTIAL P'.productlon Draft 

8. Replace the computer's lid. 

a Tip the front of the lid down so that the three square fasteners on 
the Jid catch the three hooks inside the front of the computer's case. 
(See FIgUre 2-8.) 

b. Lower the back of the lid onto the case and press down until the rear 
latches snap into place. 

c. Press on the front of the lid to ensure that the square brackets are 
fully seated on their hooks. 

d. Reinsert and tighten the security screw. 

• Figure 1-8 Replacing the lid 

Slip the hooks into these tab5--________ .L-~--L~ ____ _/ 

You are now ready to connect the Macintosh to your host. 
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The CoaxII'winax card has a muIaI mnnec10r to which you connect the 
coaxial cable. The other end of this cable should be connected to your installed 
control unit. Figure 2-9 illustrates how to connect the coaxial cable to your 
Macintosh. 

... Warning It is important to use coaxial cables bunt to the RG-62AU standard, to avoid 
radio and television interference. A 

16 Chapter 2: Setting up MacDFT 
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• figure 2-9 Connecting the coaxial cable to the Macintosh 

............. 
. ' 

Installing MacDFf software 

Insert the MacDFI' disk into your disk drive. Double-click the disk to open it. 
You should see these icons: 

• the MacDFI' appliC3tion 

• the 3270 file 

• the Apple Interprocess CcxnmuniC3tion ope) fileThe icons are shown 
Figure 2-10. 

OIapter 2: Setting up MacDFT 17 



18 

_ ,Juetlon Draft 

• Fjpte 2·10 Icons on the MacDfT disk 

o§a 
3270 M~cDFT 

Drag the MacDFI' application to your hard disk. Drag the 3270 me and the 
Apple Intetpr0ce5S Communication me to your Macintosh System 
Folder. The 3270 file contains the driver and configuration information for 
MacDFT. The Apple IPC file contains software that communicates between 
the communication card and the Macintosh II. 

After you put these files in place on your hard disk, restan your Macintosh 
computer. When you open the Control Panel, you will see the 3270 icon 
displayed. Figure 2·11 shows the Control Panel with the 3270 icon installed . 

.6. Important If you have not installed the Coax/I'winax card, the 3270 icon will not appear 
on the Control Panel. See -Installing the Hardware for MacDFT,· earlier in 
this chapter, for installation instructions for the card. e::. 
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• Figure 2-11 The Control Panel with the 3270 icon 
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After you select the 3270 icon from the Control Panel, the 3270 Control Panel 
will appear. It shows the slot in which your Coax/Twinax card is installed, and 
the ClJI' button. Figure 2·12 shows the 3270 Control Panel. The Control Panel 
displays CUT as the selected option. CUT is an acronym for Control Unit 
Terminal, a terminal emulation mode that supports one session. The other 
options, OFT SNA and OFT non-SNA, are dimmed because these options are 
not available in MacOFT application version 1.0. 
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• Figure 2-12 3270 Control Panel 

1270 

k2 
~ 
Color 

@CUT 

o OfT ISNA) 

o OfT INON-~NAI 

I Update I 

Click the Update button at the bottom of the Control Panel. Clicking this 
button tells MacDIT in which sl<x your CalxITwinax card is installed, and 
creates a MacDIT Prefs me in your System folder. After clicking the Update 
button, you see a message telling you that the configuration is updated. 

When you see the MacDIT icon on your hard disk and the 3270 icon in your 
Conto! Panel, you have installed your software. 
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Configuring MacDFf 

B EFORE USING MACOFf ON YOU, MACINTOSH n COMPIJ1'EI! TO EMUL<TE AI< IBM 

3270 Information Display System terminal, you must configure your 

MacDff software. Host equipment is configured according to the available 

equipment and needs of the users. You must configure MacDFT to 

communicate with each host configuration. So that your MacDIT software 

can emulate certain features ci the IBM terminals, you can use a 

configuration document to store your configuration choices. Using a 

MacDFT configuration document, you can launch your MacDIT application 

without having to enter configuration information each time. 

This chapter tells you how to customize your sessions and save your choices 

in configuration documents. You can then use your customized MacDff 

configuration document to stan a MacDFT session that contains your 

choices for terminal type, display options, file transfer, and other terminal 

emulation options. 

21 



• Figure 3·1 MacDfT Configure 
menu 

Terminal ••• 
Display ..• 
Keyboard ... 
Lock ... 
File Transfer • 
Country • 
From Control Panel 

ChOOSing terminal settings 

Customizing a configuration document 

When you first double-click the MacDfT application, you use a default 
configuration that causes the Macintosh to emulate a model 2 terminal. 
You can customize your application by choosing commands from the 
Configure menu, as shown in Figure 3-1. Each menu command gives you 
options for customizing your MacDfT document. 

The next few pages explain how to use all the commands in the Configure 
menu except the Keyboard command, which is covered in Chapter S, and the 
File Transfer commands, which are discussed in ())apl.er 6. Switch Settings 
for display options are also described in this chapter. The Switch Settings 
command is in the Command menu. 

. The Terminal Settings dialog box lets you make choices about the terminal 
that your Macintosh II emulates while using the MacDfT application. Figure 
3-2 shows the dialog box that appears when you choose the Terminal 
command from the Configure menu. 
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• Figure 3-2 Terminal Settings dialog box 

Termlnel Settings 

Window neme I.!!!!!!l~~ 

Emuletlon MOdellolspley Model 2 (24H80) 

f8I Open at MatDn launch 

( Ceneel ) I OK » 

This menu lets you configure your terminal emulation session by making 
these choices: 

• Window name You can rename your session window. Rename your 
session window by typing over MacDFT 1.0 with the session name you 
have ch~en. Having names fCK sessions is helpful if you log on to several 
hosts. You can rename the window name in each configuration file that 
you use. 

• Emulation model Figure 3-3 shows the menu from the Terminal 
Settings dialog box that lets you choose the display model you want 
MacDfT to emulate. The numbers refer to the number of rows and 
columns each emulated terminal provides. 

• Figure 3-3 Emulation Model pop-up menu 

DI.pIIY Model 3 (32MID) 
DI.pley Model 4 (43MID) 
II.ple ModelS (21M 1 32) 
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• Open at MacDFI'launch By clicking this check box, you tell MacDIT 
to open this window when you launch MacDfT, thereby staning the 
session with the host. If you deselect this option, you can open a 
window after launching MacDfT by choosing the Stan Emulation 
command from the Command menu . 

.& WarnJng Make your terminal settings choices before logging on to the host; if you 
don't, you must reset the terminal to put your choices into effect. The 
MacDIT application will display the alert box shown in Figure 3-4. If you 
click Yes, your conneaioo with the host is reset and you may have to log on 
again to the host. If you do ott want to reset the sessioo, click No. • 

Choosing display settings 

• Figure 3-4 Terminal settings aJelt box 

To Ins tell the chenges, the 
termine' must be reset. Do 
you wllh to proceed? 

No I Yel I 

When you choose the Display command, a dialog box appears that lets you 
choose display options. You can use each of the display options with default 
senings for your terminal emulation session, or select choices that you store 
in your configuration document. During a MacDfT session, you can change 
the display options, except for Numeric lock, without resetting the terminal. 

Figure 3-5 shows the default options you see when you choose the Display 
command. Each of these options is described after the figure. 
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• Figure loS Display Settings dialog box 

Display Settings 

o Numeric loct 

Font size: 112 

Color support: 

<i> Monochrome 
e Bese (olor 

I .ect,round: 

.Whlte 
eDerlc 

e E NI CtJlded (oll)r I 

"Seue screen" file: 

New file Select file 

Choosing numeric lock 

o Resize font 

\.I.cl (oll)rs: ",IB..,'lI;,;;H.., .. .;.,. __ ...... 

Oro!) iiiI.' 

Ceneal I OK ) 

If you select this option, you can use only numbers (0 through 9), the DCP 
key, the pericxi (.), and the minus sign (-) when you are typing data into a 
field that is defined by the host application as numeric. 

Choosing font size 

You can choose the font size elher by choosing the -font size- pop-up 
menu or by choosing the -Resize font- option. The -fOOl size- menu, as 
shown in figure 3-6, lets you select a font size. The -Resize font- option lets 
you choose whether to automatic:a11y change the font to fit the terminal 
mcxiel that the MacDFT software is emulating. 
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• Figure 3-6 "Font size" menu 

Font size 

The "Font size' option lets you change the fort size through the font menu. 
If you dick this box, you see a pop-up menu that shows your font size 
choices. The default font size is 12 points. To change the font size, choose 
either 7, 9,14, 18, or 24 points. 

Resize font 

The "Resize font' option allows you to choose whether to change the font 
size automatically when you change terminal types. The default font size is 
the largest font for a given terminal model that fits in a fully expanded 
window. The default MacDFT window size is 24 rows by CKl columns. If you 
want to change windows dimensions, use the size box at the lower-right 
corner of your window to resize the window. 

Table 3-1 shows the terminal types and the default font size. 

• Table 3-1 Terminal models and default font sizes 

TamJnal model Font size 

Model 2 12 points 

Model 3 9 points 

Model 4 7 points 

ModelS 7 points 

Rows and columns 

24 xSO 

32xSO 

43xSO 

27x 132 
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You can make two choices for resizing the font: 

• -Resize fOllt- deselectecl If you use this default setting, the window 
changes 10 accommodate the rows and columns; the font size remains 
the same size you have chosen from the -Font size- menu. If you choose 
this option, you can see aD your columns and rows. In some cases, the 
window may not be able to display all the rows and columns, and you 
must use the ICI'OU bats to display additional data. 

• -Resize fOllt- lelectecl If you use this option, MacDfT changes the 
font size to fit the terminal model you have selected, as shown in Table 3-1. 
This choice lets you display the fuB oolumn wid1h associated with each 
model type, except for Model 5, where you must use the horizontal scroll 
bars to see all 132 columns. The window size also changes to accommodate 
the extra rows and columns; the font size remains the same. 

Choosing colors 

Choices for colors depend on whether you are using a color monitor and 
whether the attached control unit supports color. figure 3-7 shows the 
portion of the Display Settings dialog box that lets you choose colors. 

• Ffpre 3·7 Color options 

Color support: 

• MonochrDme 
o 8ese (010' 

o E K1 ended ( olor i 

.ectground: 

• White 

ODerk 

\p.1p.1:1 (olors: .. 111_111_"_ .. , __ --' 

• Color Support The menu shows three buttons labeled -Monochrome,' 
-Base color, - and -Extended color. - <-Base color- and -Extended color" are 
dimmed if you use a monochrome monitor or if you have the Control 
Panel for the monkor set to monochrome.) You have these choices for 
color if you have a oolor monitor: 

o MOllochrome If you click this bunon, the monitor displays black 
and white. 
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• Figure 3-8 "Select colors· menu 

Sel("( t (0101 \: Blue ..• 
Red ••• 
Pink .. . 
Green .. . 
Turquoise ... 
Yellow .. . 
White .. . 
Background .. . 
Stetus line .. . 

e Base color If you click this button, the monitor displays four colors: 
white, red, blue, and green. 

e Extended color If you click this button, the monitor displays seven 
colors: white, red, blue, green, pink, yellow, and turquoise. 

• Background You can choose your background color by dicking either 
White or Dark. The defauh background for MacDfT is the dark 
background, which is the default background for IBM terminals. 

• NOIe: If you choose to have a white background, MacDFT will display 
whtte data from the host in black. 

• Select colors If you have chosen base or extended colors, you can 
choose the colors for your background and for the status Une. Figu re 3-8 
shows the pop-up menu that lets you choose colors. 

You can pick the exact shade ci blue, red, and other colors that you "''3nt to 
use for the named IBM color, for the window background, and for the 
status line. Figure 3-9 shows the color wheel that you use for selecting 
your colors. 
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• Figure 3-9 Color wheel dialog box 

'Ink ••• 

D 
Hue 

Seturetlon 
Brightne .. 

Red 
Green 

Ilue 

51.,1 
5995. 
65555 

65555 
2551' 
521 .. ( centel) I OK J 

To alter a color or the background or status line, selea the item that you 
want to modify. For example, say you wanted to change the color of the 
status line to pink. You would choose the -Status line· command from the 
-Selea colors· menu. Use the cursor on the cola wheel and the scroll bars to 
modify the color. The scroll bar controls the brightness of the color; the 
cursor on the color wheel changes the hue. When you have selected the exact 
shade ci pink that you want for the status line, click OK. 

Saving screens 

The Display Settings dialog bolt lets you name the me in which to save a 
screen image that you see during a MacDfT session. Saving screens is 
explained in Olapter 4. 
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Multiple configuration 
documents 

Locking MacDFf 

Saving configuration settings 

You can change configuration settings ekher before or during a session. 
After you have completed a session, if you have made changes to the 
configuration, MacDFT queries whether you want to save these changes in 
your configuration document. If you click Yes, MacDFT asks you to name 
the configuration document: you can save the changes ekher to the 
document with which you launched the session, or to a new document. If 
you click No, if you made any changes to the configuration document, they 
are not saved. 

You can create several configuration files. If you use more than one host or 
application, you can create a configuration file for each. Having several 
configuration documents is particularly helpful if you need different display 
or terminal settings for each host or host application. 

For example, say you saved your configuration settings from a session while 
you were Jogged on to a host running VWCMS. If you launch this document 
and you log on to a host running MVSrrsO, you can modify your settings, 
and save these modifications, using the Save As command 

The MacDFT application allows you to use a password as a security lock 
mechanism. This security lock mechanism is similar to the lock and key on a 
3278 terminal, but locking is done by the application software rather than a 
physical Jock and key. The lock prevents users who do not know your 
password from using MacDFT on your Macintosh, but it does not prevent 
them from using the Macintosh. 
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• Figutt 3-10 New password dialog 
box 

(nter new ,ellword: 

( Cencel I OK I 
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Setting a password 

To lock your MacDfT application, choose the Lock command from the 
Configure menu and type a password when MacDfT prompts you, as 
shown in Figure 3-10. When you type a password, the letters you type are 
masked out on the screen by asterisks ("). Your password can be up to 16 
characters long. 

When you are typing your password, you see the dialog box shown in Figure 
} 1 0 After you enter or delete your password, you see the dialog box in 
Figure 3-11, prompting you to confirm your password. 

• Figure 3-11 Password conflI1llation dialog box 

Please enter possword 

egaln to confirm: 

II 
tancel I OK I 

The dialog box in Figure }12 appears when you launch MacDfTafter using 
the Lock command. After you have ch~n your password, MacDfT asks 
you for this password each time you launch. After you type your password, 
the MacDfT software lets you launch your application. 

Chapter 3: ConfIgUring MacDFT 31 



Country customlzatlon 

Configuring from the 
Control Panel 

• Figure 3·12 aMacDIT locked" box alert 

~ ~.tDrrl.lott.d. 

U PI ••••• nt.r p ... wDrd: 

II 
Quit I DK I 

Changing or deleting a password 

You can change or delete your password after you have entered the correct 
password. First,chOClSe the Lock command from the Configure menu. 

• To change your password, type a new password in the text box. A dialog 
box appears that asks you to type your new password again. Type your 
new password exactly as you typed it the first time. 

• To delete your password, type no characters; just click OK. When you are 
asked to confirm your password, click OK again. After you delete the 
password and dick OK, MacDFT is unlocked. 

Lost password 

If you have lost or forgotten your password, you or your system 
administrator can launch an unlocked copy ci MacDFT. Copy the unlocked 
copy to your hard disk, launch the application, and chOClSe a new password. 
Be sure to discard the locked copy. 

MacDFT can be localized for use in different coontries. Supported countries 
will appear when you click the Coumy menu option. 

This command allows yoo to reconfigure MacDFT from one Coax/rwinax -
card to another card. When you choose this command, yoor session will be 
reset, and the current values configured in the Control Panel will be used to 
start the new session. 
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You can change Switch Settings by choosing the Display Switches command 
in the Command menu. Switches Settings are displayed in a dialog box as 
check boxes and buttons, as shown in Figure 3-14. 

If you make a change to the Swlch Settings dialog box, you can save the 
change as part d your configuration document See the section titled 
"Saving Configuration documents .. earlier in this chapter. 

Figure 3-13 shows the default settings for the options in the Switch Settings 
dialog box. To change a setting, dick a check box a- button. An X in a check 
box or a dark circle in a button indicates that the option is chosen; an empty 
check box or button means that the option is not chosen. 

• Base Color Switch You can choose either four cola- or two color for 
your base color selection. 

[J If you select -,wo color,· base color is nOl used and the session 
operates using two colors, green and white, emulating a monochrome 
display. 

[J If you selea 'Four color .. the terminal runs in normal base color 
mcxie, except when extended color attributes are specified by the 
host; in this case, the switch selting is ignored. 

The base color switch is dimmed if rnonochra-ne has been selected in the 
Display Settings dialog box, if you have a monochrome monitor, or if you 
have color monitor that is configured for monochrome in the Control 
Panel. 
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• FJaurt 3-13 Switch Settings dialog box 

Swltcb SeUlngl for MecOFT t.O 

aMP. [olor su.\f (" 

<i> foul' (olor [········1 

Cursor Type 

<i> UnderlIne cunor 

o Two color 1'---) 

o lIoct cursor 

o Cunor bllnt o Sbow curlor position 

Click on keystrokes If 000 

o Input Inhibited 0 Nonnal <i> Neuer 

( Cllncel I OK » 

• Cursor Type The cursor can indicate its ~ition by underlining the 
character or by forming a block around the character. The default is 
underline; if you select "Block cursor,· the host displays a rectangle 
surrounding the character on which the cursor lies. 

• Show cursor positlon If you choose ·Show cursor position,· the 
current cursor position is displayed on the status line at the right side. 
The cursor ~ition is indicated by two numbers separated by a slash CO; 
for example, 061 07 means that the cursor is on the sixth row and seventh 
column. 

• Cursor blink You can c~ whether you want your cursor to blink. 

• Click on keystrokes if You can choose when you want your 
keystrokes to click. If you choose this option, MacOfT simulates the 
click of the emulated terminal. 
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Communicating With a Host 

T lIE MACDPT ,lOG"" ENABIlS YOU 10 USE YOUI MACN10SH n COMPUTER 10 

communicate with an IBM host. This chapter describes the procedures for 

launching MacOfT, copying and pasting data between applications that you 

run on the host and on the Macintosh computer, and terminating the 

session. It also addresses printing, using Autokey features, and using the 

Command menu. 
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Launching from the icon 

Launching a configuration 
document 

Starting an emulation 
session 

When you use MacDFr on your Macintosh computer cormected to a host via 
a control unit, your computer has these capabilities: 

• You can use the MacDFr program to read and edit fdes or execute 
programs on your IBM host. 

• You can copy and paste text between applications running on the 
Macintosh and the IBM host. 

• You can transfer whole documents between the Macintosh and IBM 
host by using the FUe Transfer command. File transfer is described in 
Chapter 6. 

Launching MacDFf 

To begin a terminal-emulation session, you can either double-click the 
MacDFr application icon or double-click a MacDFr configuration document. 

If you double-click the MacDFr application icon, MacDFr launches the 
default configuration settings that causes the Macintosh to emulate a model 
2 terminal. 

You can also launch MacDFr by Simultaneously pressing the Command key 
and double-clicking the application icon. This causes the New and Open 
commands to be enabled in the File menu, letting you open a customized 
configuration document or a new configuration document. 

If you double-click a configuration document that you have customized as 
described in Chapter 3, MacDFr software emulates the terminal type and 
display choices you have configured. 

After launching MacDFr, you see the host's initiallog-on screen. Typically, 
you must have an account and password to log on to a host. 

• NOIe: If you are unsure about your host accoont or password, see your -
system administrator for this information. Follow the procedures at your 
site to log on to the host 
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After logging on to the host, you can do all the things that you normally 
would do while logged on to a host, such as browsing and editing files, using 
host appUcatioos, and executing programs. You can also change your 
display options, and copy and paste text between applications that are 
ruMing on the host and on the Macintosh. 

• Nole: If you do n<X see on-line symbols in the status line, your coaxial 
cable may not be connected. Check the coaxial cable attached to your 
Macintosh If. If the coaxial cable is correctly attached and you do not see 
on-line symbols, caU your system administrator to determine the 
problem 

To change your display options during a terminal emulation session, choose 
the Display command from the Configure menu. Choose from the options 
listed in the Display Settings dialog box. For information on how to configure 
these options, see Chapter 3. 

Copying and pasting host data 

MacDfT allows you to use the standard Macintosh copy and paste functions 
to transfer information between documents. MacDfT suppons copying and 
pasting text between applications on the Macintosh computer, such as 
MacWrite-, and text editing applications on the host, such as XEDIT. If you 
are not familiar with copying and pasting text between documents, see your 
Macintosh If owner's guide. 

You can copy text between applications that run on the host and your 
Macintosh computer. 

Copying text from the Macintosh to the host 

To copy data from the Macintosh and paste it to the IBM host application, 
follow these steps: 

L In the application window, select the text you want to copy. Then 
choose the Copy command from the Edit menu. 
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Copying tables 

2. Click the MacOfT session window. 

2. Seled the host application into which you W3nt to copy text. 

3. Place your cursor where you W3nt the text to appear, and choose the 
Paste command from the Edit menu. 

• NOIe: Some applications on the host have proteded fields, that is, fields 
in which you are not allowed to type. If you paste text into an application 
that has proteded fields, pasting stops when you get to a proteded 
field. Pasting data that you have copied from a host application may have 
an extra character space in every field. 

Copying text from the host to the Macintosh 

To copy data from the host and and paste it to the Macintosh, follow these 
steps: 

1. Seled the text that you want to copy from the host application. Then 
choose the Copy command from the Edit menu. 

2. Seled the Macintosh application into which you want to copy text. 

3. Place your cursor where you want the text to appear, and choose the 
Paste command from the Edit menu. 

• Note: Pasting data copied from a host application may have an extra 
character space in every field 

The Copy Table command in the Edit menu lets you copy tabular information 
from the host to an application on the Macintosh. This command is useful 
for copying information into spreadsheets or databases on the Macintosh 
computer. The Copy Table command translates a string of two or more 
spaces into a tab character. 

To copy tabular information, follow these steps: 

L Open the host application and seled the information you want to copy. 

2. Copy the information by choosing the Copy Table command 

3. ~ the Paste command from the Edit menu, and paste the text you 
copied into a Macintosh me or application. 
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• Note: You can use the Command key while selecting text to modify the 
selection rectangle. If you hold down the Command key while selecting 
text, you can copy sections d text that do not extend to the window 
margin. 

Terminating the session 

The File menu provides commands for terminating a MacDFI' session. Figure 
4-1 shows the File menu with the Close, Close All, and Quit commands for 
terminating a session. Typically, you must log df the host before 
terminating the session. If you are unsure about your site's procedures, see 
your system' administrator . 

• Figure 4-1 File menu with Close, Close All, and Quit commands 
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The Close command closes the session on the host, but keeps the 
configuration document that you launched open. After using the Close 
command, you can start a new session by choosing the Start Emulation 
command from the Command menu. 
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OoseAll 

Quit 

The Oose All command closes the session and configuration document, but 
keeps you in the MacDfT application. You can start another emulation 
session by choosing the New or Open command from the File menu, and 
then choosing the Start Fmulation command from the Command menu. 

When you choose the CJose All command, MacDfT queries whether you 
want to save your configuration document. If you have changed your 
settings; dick Yes if you want to save your changes; dick No if you do not 
want to save your changes. To start a new emulation session, you must 
reconnect 

The Quit command terminates your session and closes the MacDFT 
application. If you have made changes to the configuration, MacDFT queries 
whether you want to save these changes in your configuration document. If 
you click Yes, MacDfT asks you to name the configuration document; you 
can either save the changes to the document with which you launched the 
session, or to a new document. If you click No, any changes you have made 
to the configuration document are not saved. 

Printing with MacDFT 

You can print documents and files produced during your MacDfT session. 
You can use either an Apple printer that is connected to your Macint~h, or an 
IBM printer that is connected to the control unit to which your Macintosh is 
connected. 

D,. Important You cannot use your Apple printer for host-initiated printing. Do 

Printing documents on an 
Apple printer 

If your Macintosh II is connected to an Apple printer, you can print 
Macintosh-resident documents during a MacDFT session. You can use any . 
type of printer supported by Apple. You can print documents that you have 
created during a MacDFT session, or documents that you have downloaded 
from the host. 
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You can print host-resident documents during a MacDFT session to an IBM 
printer that is camected to your control unit or host. Use the print 
commands that are supported in your IBM environment Figure 4-2 shows 
one possible configuration of MacDFT with a system printer attached to the 
control unit. 

• FJaure 4-2 MacDFT coof'l8Utation with an IBM printer 

Host 3X74 conttol unit Macintosh n 

Printing or saving a screen The File menu has two commands for creating screen images: Print Screen 
image and Save Screen on disk. 
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• Figure 4-3 File menu 
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• Nole: Local ropy. as it is understood by the IBM community, means 
sending a snapshot of your screen to the control unit, which prints it on a 
3287 printer. MacDFT version 1.0 does ncl support host or terminal local 
copy. However, you an create a screen image that you an save to disk or 
print from the Macintosh II computer during a MacDFT session. 

Print Screen 

To print a terminal screen that you see during a MacDFT session, choose the 
Print Screen command. The terminal screen image is printed to an Apple 
printer that is avaDabie to your Macintosh II. 

Save Screen on Disk 

MacDFT lets you save a screen image that you see during a MacDFT session . 
The Save Screen on Disk command is dimmed until you have chosen the 
Display command and selected either the New File or Select File button in the 
Display Settings dialog box. The screen image is saved as a text file. Figure 4-4 
shows you the portion of the Display Settings dialog box that lets you name 
the screen image. 

• Figure 4-4 "Save screen" file option 
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The Display Settings dialog box lets you choose one of the three buttons: 

• New rue Select this option to create a new fdename on your disk. 
MacDFT will then prompt you for a new filename. 

• Select file After you choose this option, you see the alert box in Figure 
4·5. This option lets you choose whether to append or replace the 
contents of a fde on your disk with a new screen image. 
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• Drop me Select this option to remove the filename and its path from 
the Display Settings dialog box. 

Oick OK at the lower-right comer ri the Display Settings dialog box. MacDfT 
places the file in the window that is currently open, showing the pathname. 
The pathname shows the folder in which it resides on your disk. For example, 
Figure 4-6 shows a file that has been named. 

• Figure 4-6 • 'Save screen' me" option with a filename 
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After you have clicked either "New file" or "Select file," name your file by 
typing the name under • 'Save screen' me." When you have the image on 
screen that you want to save, go to the File menu and choose the Save Screen 
on Disk command; this causes the screen image to be saved to your disk. In 
the example shown in Figure 4-6, the file "fred" will be saved to the disk 
"home." 

Before using the contents of a screen you have saved to disk, you must first 
open the file using a text processing application, such as Mac~'rite or 
Microsoft Word. 
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• Figure 4-7 Autokey menu 
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Using the Autokey menu 

The Autokey feature lets you store strings of keystrokes that you use 
frequently in an emulation session. When you choose an Autokey item, the 
keystrokes stored in the Autokey item are played back as if you had just 
entered them with the keyboard. The Autokey menu is shown in Figure 4-7. 

To create an Autokey sequence, go to the Autokey menu and choose New. 
You see a tat box labeled • Autokey: Untitled,- with a sequence number. 
Figure 4-8 shows • Autokey: Untitled -1.-

• Figure 4-8 Autokey Untitled window 

. - - - Rutoke : Untitled - 1 
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Type the string you want in the Autokey box. If you make a mistake, use the 
Cut or Oear command from the Edit menu. If you use the Delete key, it 
becomes part of the string. Figure 4-9 shows an Autokey window with text 
entered. 

• fJaurt 4-9 Autokey window with string of text 

Rutote : Untitled - 1 
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Use the Save As command to give your Autokey a meaningful name. Figure 4-
10 shows the dialog box you see when you choose the Save As command 
after entering text in an Autokey window. In this example, the log-on 
Autokey is named "logon fred." The maximum size for the Autokey name is 
22 characters. 
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• Figure 4-10 Naming your Autokey 
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In the example in Figure 4-10, the "Include in Autokey Menu' box was 
selected, and the "Keyboard Equivalent" text box appears. You can assign a 
keyboard equivalent to your Autokeys. Be careful not to select one of the 
standard Macintosh keyboard equivalents, or one that is already assigned. If 
you select a duplicate, an alert box will tell you that you must rename the key. 
See your Macintosh owner's guide for a list of assigned keys. 

If you click "Include in Autokey menu," Autokeys that you have created and 
saved in a configuration document are listed and can be played from the 
Autokey menu. Autokeys can also be assigned to and played from the 
Keypad dialog box, described in Chapter 5. 

If you do not use the Save As command from the File menu after entering an 
Autokey string, you are prompted by the alert box shown in Figure 4-11. 

• Figure 4-11 Save Changes alert box 
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If you click Yes, you see the dialog box shown in Figure 4-10. 
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The Autokey feature provides commands to edit, delete, play, pause, and 
resume Autokey sequences that you have created. . 

The Edit command brings up a saoIlable list of Autokey strings that exist in 
your current configuration document, and two buttons, Edit and Odncel. If 
you click a name from the list and choose the Edit command, you can edit the 
string and save it. 

The Delete command lets you delete an Autokey entry. Select the Autokey 
item that you want to remove from the dialog box, and choose the Delete 
command. 

The Play command executes the Autokey sequence. For example, if you 
created an Autokey named "logon fred,· yoU can choose the Play command 
and choose -logon fred." You can also add it to the Keypad, or play it by 
pressing its keyboard-equivalent keys. The host receives the message exactly 
as it was entered. You will see the letter Pon the status line while you are 
playing the Autokey sequence. 

The Pause command tells the Macintosh to halt execution of an Autokey 
command until you choose the Resume command from the Autokey menu. 
When you select Pause, the letters PP appear on the status line, indicating 
that you have clicked Pause, and the Resume command appears in the 
Autokey menu. The letters PPdisappear after you choose the Resume 
command. 

The Odncel command tells the Macintosh to cancel the Autokey sequence. 

Using the Command menu 

The Command menu provides three functions for terminal emulation 
sessions. Figure 4-12 shows the Command menu. 
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Start Emulation 

Display Switches 

Reset Terminal 

• Figure "·12 Command menu 
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The Start Emulation command allows you to begin an emulation session 
after choosing the Oase conunand from the File menu. 

The Display Switches command lets you change display options using a 
dialog box. See the section in Chapter 3 titled "Choosing switch settings." 

The Reset tenninal command lets you end your lenninal emulation session 
and begin a new session immediately. Figure 4·13 shows the alert box that 
you see if you choose the Reset Tenninal command . 

• FJaure "-13 "Reset Terminal" alert box 
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If you click Yes, your connection with the host is ended and you are 
reconnected to the host. You may have to log on again. If you do not want 
to reset the session, click No. 
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C HAP T E R 5 

-----------------------------------Using the Keyboard and Keypad 

T HE MACINlOSII KEYBOARD 5 CONIIGURED TO 1UNCJ10N AS AN mM 3270 

terminal keyboard. Since the Macintosh has some keyboard features that are 

different from those of the IBM terminals that it emulates, the MacDFT 

application provides two features that enable you to work efficiently with 

keyboard differences. USing the Option and Command keys, you can use the 

Macintosh keyboard with the functionality of the IBM keyboard; and you 

can send mM keystrokes from the Keypad menu. This chapter explains how 

to use and customize both of these features. 
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Mapping key functions 

Macintosh and mM 3270 keyboards 

Because the IBM keyboard has some keys that are ntt standard on the 
Macintosh keyboard, MacDFr has a keyboard mapping feature. The keyboard 
mapping feature allows you to map key functions found on the 3270 tennina! 
to the Macintosh standard or extended keyboard. These key functions are 
c&cussed in a section tlled ·3270 Key Functions.· 

To display the Macintosh keyboard and mM keyboard on your screen, pull 
down the Configure menu, and choose the Keyboard command Figure 5·1 
shows the Configure menu. 

Figure 5·2 shows the dialog box that appears when you choose the Keyboard 
command. The keyboard window displays two keyboards: an IBM 3270 
keyboard and either the standard or extended Macintosh keyboard, depending 
on which keyboard is connected to your Macintosh. Figure 5-2 shows the 
Macintosh extended keyboard. 

The 3270 keyboard is in the upper half of the window, and the Macintosh 
keyboard is in the lower half of the window. Keys that are dimmed cannOl be 
mapped. You can reassign all 3270 keys to the Macintosh keyboard, except for 
the Lock, Shift, and Alt keys. You cannot reassign a 3270 key function to a 
dimmed key on the Macintosh keyboard. 
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• Figure S-2 Macintosh and 3270 keyboards 
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Keyboard mapping tools 

MacDFT provides buttons to help you map 3270 keys to the Macintosh 
keyboard. The 3270 keyboard has three buttons that represent modifier keys: 

• Unshifted 

• Shift 

• AlI 
The Macintosh keyboard has four bunons: 

• Unshifted 

• Shift 
• Option 

• Corurol 
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3270 keys 

Oicking any d these buttons reveals the current key assignment associated 
with these modifier keys. The Shift button. for example. causes all the 
alphabetical keys to be displayed as uppercase letters. Try selecting each 
button to see how your screen display changes. On the Macintosh keyboard, 
you can use the buttons on the screen or the key on your keyboard to change 
your display. 

You can map keys from the IBM keyboard that are combined with the Shift 
or Alt key to the Macintosh keyboard in either Unshifted, Shifted, Option, or 
Coctrol mode. The keys that you can reassign are 3270 function keys: Enter, 
Program Function keys 1-24, PAl. PAl. Oear. Attn. Sys Req, Reset, the arrow 
keys. New Line. Home. Tab. Backtab, Insert, Delete. Erase £OF. Erase Input, 
DUP, and FJeld Mark. If you are already famUiar with 3270 keys, you can skip 
ahead to -Mapping the 3270 Function Keys to the Macintosh Keyboard.' 

The 3270 keys are divided into four major groups according to function. The 
sections that follow provide an overview of 3270 keys. If you n~d 
instructions for using a key's function, refer to the host application's 
documentation. 

Program function keys 

There are 24 Program Function (PF) keys,labeled PFI through PF24 on your 
keyboard. The host application you are using assigns its own functions to 
these keys; refer to the application's manual for specific functions. 

Program Attention key 

MacOn' supports two Program Attention keys, PAl and PA2. The 
application program you are using determines the function d these keys. 

3270 function keys 

The 3270 function keys give commands that are standard throughout 3270 . 
communication. Table 5-1 gives a complete name for each function and 
briefly describes each function. 
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Cursor movement keys 

The cursor movement keys move the cursor on the screen. This function is 
local; no host processing is involved. 

• Table >-1 3270 fur¥:tion keys 

Key 

Clear 

DUP 

Enter 

Erase to End of Field (EOF) 

Erase Input 

Field Mark 

Home 

Newline 

System Request 

Attention 

Arrow keys 

Function 

Clears the saeen during a session. 

Allows you to duplicate the information in one 
field into another field. 

Sends a request for attention. 

Erases data from the cursor location to the end 
of the input field. 

Erases data in all input fields. 

Puts the Field Mark character into the current 
input field. The application program determines 
its function. 

Returns the cursor to the first non protected 
field. 

Moves the cursor to the next line, or to line one 
if there are no input fields. 

Either sends a signal to the host system to tell 
the program you have a test request message, 
or clears the display screen and switches the 
display station between the application and the 
control program. 

Requests the attention of the host. 

Moves the cursor in the direction of the arrow. 
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Mapping 3270 function 
keys to the Macintosh 
keyboard 

Table 5-2 shows key reassignment for special characters that do nOl exist in 
ASCII, but are used in EBCDIC. 

• Table 5-2 Key reassignment for noosupported Macintosh special characters 

EBCEDle character 

The cent sign (¢) 

logical NOT sign (.,) 

Broken vertical bar (~ 

Macintosh key (ASCII character) 

When you map a 3270 function key to a key on the Macintosh keyboard, 
pressing that Macintosh key causes it to have the 3270 function. For example, 
you could map the 3270 delete symbol to the Macintosh keyboard with the 
Option button selected. When you press the Macintosh Option key and the 
key that you have mapped, you send a delete keystroke. This section explains 
how to change the function of a key and how to delete a function from the 
keyboard. 

Changing the function of a key 

Here are two ways to assign the function of an IBM key to a Macintosh key: 

• Drag the key from the IBM keyboard, and position it on the Macintosh 
key on which you want to assign it. Release the mouse button. 

• Click the key on the IBM keyboard that you want to move to the 
Macinta;h keyboard. dick the key on the Macintosh keyboard that you 
want to have the function of the IBM key. 

Figure 5-3 shows a key assigned to a new function. 
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• Flgurt 5-3 Key with a new function 

i; .. -
.r~~~~~~~~~~~~ t • 

~L-~~~~~~~~~~ __ ~ • ~ 

IfD rM PI\5 

"" "'" rill 

1M Prill 1m 

rm PIlI '1M 

aD '.slllft.. 0 SlIIft 0 In 

lui . I . 
1 II 9 -
1 5 6 .. 
I 2 3 

0 lIT. 

O ... hIHecI OSN" •• ,1I1Ift OC.,,'nl 

IIIp 'rllt ( hleel I I III( I 

Deleting the function of a key 

To delete the function of a key that is mapped with a 3270 function, click it, 
and drag that key to the trash can, and release the mouse. The key \\nere the 
3270 function had been becomes blank. 

After you have deleted the 3270 function from a key, you can map another 
3270 function key to the blank key, you can replace the key's original 
function, or you can leave it blank. 
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Saving your customized 
keyboard 

When you have made all your key mapping seleaions, click the OK button to 
save your choices. If you have made choices that you do not want to save, 
click the Cancel button. This causes the keyboard to revert to the last saved· 
keyboard settings. You can save your choices into a configuration document 
by choosing the Save A! canmand from the FDe menu; your keyboard 
choices become part of the configuration document. For more information 
on conf'tgUration documents, see Chapter 3, ·Configuring MacDfT.· 

The keyboard provides on·line help for using the keyboard. Select the 
Keyboard Help button fran the Keypad dialog box. The Help screen in Figure 
5-4 appears. 

• Figure 5-4 Keyboard Help screen 
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Using the keypad 

The keypad is a tear~ff menu that enables you to send keystrokes without 
using the keyboard. You can aeate a customized keypad menu that contains 
the keystrokes you most frequently use, and tear if off to the comer of the 
window of your MacDFI' session. The keypad configuration is shown in 
Figure 5-5. 

• Figure 5-5 MacDFI' keypad 
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Clicking a key from the keypad produces the same result as pressing the key 
on your Macintosh keyboard, including the playback of any Autokey item 
that you assigned to the keypad. 
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Mapping a command on 
the keypad 

Creating a customized 
keypad 

Saving your customized 
keypad 

MacDPI' lets you customize your own keypad by mapping 3270 function 
keys to the bottom keypad shown in Pigure 5-5. To map a function from the 
Keypad menu, select the func.tion by dicking it Then, dick any pad on the 
keypad. After saving the keypad, you can execute the function you have 
mapped by selecting it from the keypad. You save the keypad to which you 
have mapped functions by using the Save or Save As command from the File 
menu. TO delete a function from the keypad, dick the function and drag it to 
the trash can. 
If you have aeated Autokeys with the Autokey menu, you can assign them 
to the Keypad. Select an Autokey kern from the scrolling Autokey list, and 
click the new keypad where you want to place the Autokey. See Chapter 4 for 
more information about Autokey functions. 

You can customize a keypad to contain the functions you use most 
frequently. Choose the New command from the Keypad menu. Assign the 
keys and Autokey items that you use frequently and save the customized 
with a name. You can use the size box to resize your customized keypad. 
Pigure 5-6 shows an example of a customized keypad. 

• Figure ~6 A customized keypad 
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When you have made all your keypad selections, click the Save button to save your 
choices. If you have made choices that you do not want to save, click either the 
~cel or Revert to Saved button. This causes the keypad to reven to the last-saved 
keyboard sellings. You can also save your choices into a coofiguralion document by 
choosing the Save command from the File menu. Your keyboard choices become 
part of the current configuration document. For more information on 
confIgUration documents, see Chapter 3, ·Configuring MacDFl'." 
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The Keypad provides on-line help for using the keypad. Click the Keypad Help 
button on the Keypad dialog box. The Help screen in Figure 5-7 appears. 

• FIpre 5-7 Keypad Help screen 
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Transfening Files 

T HE MAClNTOSII AND TIlE mM HOST RUNNING TIlE VWCMS OR MVstrso 

operating system can share files through file transfer. Unlike copying and 

pasting, discussed in Chapter 4, file transfer lets you copy complete files 

between the Macintosh II computer and the IBM host. File transfer consists 

of two parts: configuring your choices for file transfer and executing file 

transfer commands. This chapter describes both parts of the file transfer 

process. 
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• Figure 6-1 File Transfer 
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Configuring rtIe transfer 
The File Transfer command in the Configure menu lets you choose the 
direction for file transfer and the operating environment, either VM!CMS or 
MVS/TSO. You can either upload files from the Macintosh to the host 
running VWCMS or MVSII'SO, or download files from the host to the 
Macintosh. 

Figure 6-1 shows File Transfer command configuration options. These 
options are discussed in the next section. 

After you have configured file transfer, all subsequent file transfers follow 
the choices you have made, until you choose the File Transfer command 
again. If you want to transfer another type of file, choose the File Transfer 
command from the Configure menu again, and choose the appropriate 
configuration for your next file transfer. 

Because VWCMS and MVSITSO are different operating systems, each has 
different parameters that you must specify before transferring files 
between the host and the Macintosh. MacDfT supplies you with default 
file-transfer parameters that are described in the section that follows. Each 
File Transfer configuration dialog box displays a different set of these file
transfer parameters, depending on the file transfer direction, the file transfer
mode, and the operating system. Unless otherwise stated, a parameter 
applies to both host environments. 

You can change these values, but be sure that the host accepts the values 
you are selecting. If you are not sure what values the host accepts, check 
with your system administrator. When you upload a file that replaces or 
appends an existing file, you must specify the same configuration 
parameters as the existing me. 6 
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• Transfer Mode 

o Tat Use this option for files that contain only Text (ASCII 
characters only). Before uploading a file as a Text file, save it as -text 
onlYi- formatting information such as bold or italic is nOl transferred 
to the host. 

o Binary Use this option for files that contain nonASCII characters. 
Binary files canna be transferred as Text files. Text files, however, 
may be sent as Binary files. 

o MacBinary Use this option only for Macintosh-created files that you 
want to use on a Macintosh. MacBinary transfer preserves all the 
Macintosh-specific information needed by the Macintosh file system. 

+ Note: Text and binary file transfer modes do nOl preserve information 
needed by the Macintosh file system. 

• Other Option 

o CR is record separator If you click this option, MacDFT software 
uses a carriage return (CR) as the record separator This option works 
only for text files. 

o Append CR. to each line If you click this option, MacDFT uses a 
carriage return (CR) as the record separator. This option works only for 
text and binary files. 

o Append to Host File If you click this option, MacDFT appends this 
file to the already existing host file named in the upload dialog 
configuration dialog box. This option works only on text and binary 
files. 

If you choose to have a carriage return function as the record separator, files 
that are uploaded in fIXed-length record format will be received by the host in 
variable-length record format. t:::. 

• Overwrite option You can choose whether you v.ant the file you 
are transferring to overwrite an existing file with the same name. 
0I00se one of the following. 

o Yes If you click this option, MacDFT overwrites a named file 
without a warning dialog box. 
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CJ No If you click this option, MacDFT does not allow a file to be 
overwritten. 

CJ Append If you click this option, MacDFT attaches this file to the 
named file, in the download dialog box for text and binary files. 

o Ask First If you click this option, MacDFT first provides a 
warning dialog box. 

• Record Format 
o· Fixed This option indicates that all records in the file have the same 

fIXed length. 

CJ Variable This option indicates that the records in the file do not 
have the same length. A length field is available at the beginning of 
each record. 

o Undefined This option indicates that the file is nct record oriented, 
and therefore does not have any length attributes. 

• eMS rue mode The file mode is split into two components, a letter and 
a number. The letter specifies the virtual disk on which the file is to be 
located: A is the primary disk, and is the default. The number signifies the 
access type: 1 is read/write, and is the default. List your file and type in 
the value for the file mode, if it is not At. 

• 1'50 Allocation You can change the value for TSO allocation and 
override the default allocation. Check with your system administrator for 
the appropriate range of values. You can specify space in tracks, block, or 
cylinders. Type the new values in the text box for primary and secondary 
space for TSO allocation, where primary and secondary are appropriate 
values for your host, as shown below. 

space (qty,incr) [AVBLOCK(value) ITRACKSICYLINDERSl 

This command specifies the amount of space to be attached for a new 
file. Use qty and incr to specify the amount of primary and 
secondary allocations. The smallest quantity of space is AVBLOCK, the 
medium quantity is TRACKS, and the largest quantity is CYLINDERS. 
If you don't specify the 1'50 allocation option, 1'50 uses default values. 

• Record Size Record size indicates the record size for the IBM file. The 
default for text fdes is 80 bytes; the default for binary or MacBinary files . 
is 256 bytes. To change these values, type in the desired value for record 
size in the text box. 
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• Block Size Block size refers to the block size of the IBM file. The 
default is 800 bytes. 

After you have made your selections, click OK. If you change your mind, click 
Cancel. To begin file transfer, use the Transfer Files command in the File 
menu. 

Configuration for uploading a me to a host running MVSrrSO 

Figure 6-2 shows the dialog box that you see when you choose the TSO 
Upload command from the File Transfer po~up menu. 

• Figure 6-2 1'50 upload configuration dialog box 

TSO Uploed Parlmeters 

Trensfer Mode 

@)TeHt 

o Binary 

o MacBlnary Document 

Other Option 

181 tR is record separator 

o Append to Host File 

TSO Allocetlon I :;:====;----;::==...., 
Record Size 1_0 Bloct Size .... IB_oo_-' 

Record Formet @) lIerllble 0 FIHed 0 Undefined 

( (encel 1 I OK J1 

After you have made your choices, click OK. 
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Configuration for uploading a me to a host running VM!CMS 

Figure 6-3 shows the dialog box that you see when choose the eMS Upload 
conunand from the File Transfer pop-up menu. 

• Figure 6-3 VM/CMS Upload confJgUration dialog box 

DM/CMS Upload 'Irameten 

Transfer Mode 

~TeNt 

o Binary 
o MecBinery Document 

File Mode ~ 
Record Size I!!::J 
Record Formet 0 FiNed 

Olher Option 

~ eR II record IIparator 

o Rppend to HOlt rile 

il Derieble 

I GK I 

After you have made your choices, click OK. 
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Configuration for downloading a file from a host nmning 
MVS/I'SO 

Figure 6-4 shows the dialog box that you see when you choose the TSO 
Download command form the File Transfer pop-up menu. 

• FJpre 6-4 TSO download confl8Uration dialog box 

lSO DDlllnlDe" '.nlm.t.rs 

'nlnsf.r Mod. 

@lTeNt 
o Binary 
o M.cBlnery Dotument 

O ... rwrlte Option 

0..... ONO 

o Rppend 

Ci Rslc First 

Dtll.r Dptlon 181 Rpp.nd tR to •• ch line 

( Cencel 1 I OK I 

After you have made your choices, click OK. 

Chapler 6: Transferring Files 67 



Apple Confidential 

68 Chapter 6: Transferring Files 

Preproduction Draft 

Configuration for downloading a me from a host running 
VM/CMS 

Figure 6-5 shows the menu that you see when you choose the CMS 
download command form the File Transfer pop-up menu. 

• Ffpre 6-5 VM/CMS download confJ8Uration dialog box 

PM/eMS Download 

Tronsfer Mode 

@>TeMt 

OBlnery 
o MetBlnery Document 

Dporwrlte Option 

o Yes ONO 

OllppeRd 
@IISk Fint 

Other Option I8Il1ppeRd ell to ooth line 

CMS FII ..... od. ~ 

(toneel) I OK I 

After you have made your choices, click OK. 
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Transferring rues 
To execute file transfer, choose the Transfer Files command from the File 
Menu. You must be logged on to the host, and the Ready prompt must be 
displayed. You cannot use any host application while transferring files. 

+ Note: Because of the way data is stored and formatted on the Macintosh, 
some reformatting of text files is necessary after a file is uploaded to the 
host. 

Choosing the Transfer Files command from the File menu brings up the File 
Transfer dialog box, shown in Figure ~6. 

• Figure 6-6 File Transfer dialog box 

-~~~-

---------- FT for MDCOFT 1.0 ="-------- ------

3270 File TrDnsfer Protocol 

MessDges 

To 1nvoke File Tnnsrer, choose either TSO or eMS, end 
then click Uploed (to Host) or Downloed (from Host), 

IBM Host @TSO oeMS 

Upload [Oownloed] Cencel 
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• ChOOK the host operating environment aick either TSO or eMS. 
You must be sure that the host operating environment you choose 
matches the host to which you are logged on. The default operating 
system is the that one you most recently configured in the File Transfer 
command in the Configure Menu. 

• Choose the direction for file transfer aick either Upload or 
Download to go to the next dialog box for fde transfer. The Upload dialog 
box is shown in Figure 6-7; the Download dialog box is shown in Figure 6-8. 

. ./ 
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Figure 6-7 shows the dialog box that appears when you click the Upload 
button in the File Transfer dialog box (shown in Figure 6-6). This example 
shows a listing of files that can be uploaded to the host. 

• Figure 6-7 Upload dialog box 

Ie spetlel projects I 
::::J dllllUUru 1'1111'11 t \ ~ 
C artlsens 
C entertainment 
C phones 
C sites 

Host file neme 

Follow these directions to upload a file: 

c:::Ihome 

E jcu t 

Drlue 

Upload 

Cencel 

1. Type the host filename and me type in the text box. 

2. Choose the folder from which the me will be uploaded. Figure 6-7 shows 
the files that can be uploaded from the special projects folder. If you 
want to choose another folder, click the text box for folders to choose 
the folder you want. 

3. Click the Macintosh filename in the list. 

4. Oick the Upload button to start the file transfer. If you click Cancel, you 
return to terminal emulation. 

l:::. Important If you are uploading a file to a VWCMS host, you must specify the file name 
and file type. If you do not specify the file mode, the default file mode, Al is 
used. /::;, 
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Figure 6-8 shows the dialog box that appears when you click the Download 
button in the File Transfer dialog box. 

• FIpre 6-8 Download dialog box 

leg projects I 
o artisans 
o entertainment 
o phones 
o sites 

5aue File as: 

Icopy o~ 

Host file name 

I 
II. 
iili 

(5 

c:::lhome 

( . [JP.C1 ) 

[ Drlue 

[Download] 

Cancel 

Follow these directions to download a file: 

1. Type the Macintosh filename in the upper text box. You can either type 
over the ·Copy or portion of the upper text box, or type after the words 
·Copy or to name the me a copy of the file that you are downloading. 

2. Type the host filename in the lower text box. 

3. Choose the folder in to which the file will be downloaded. When you 
download a file, the file is placed in the folder shown in the dialog box, 
above the file listing. Figure 6-8 shows the downloaded me loaded into 
the projects folder. If you want to choose another folder, click the text 
box for folders to choose the folder you want. 

4. Click the Download button to start the file transfer. If you click Cancel, 
you return to terminal emulation. 
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The dialog box shown in Figure 6-9 appears after you have clicked either the 
Upload or Download button. It shows the File Transfer dialog box with the 
file names for the host and Macintosh flies, and the file transfer status 
displayed in the Messages area. 

• FJcure.9 Bealnn'" me transfer 

- - - ~ -
---~------ n for MacOn 1.0 

3210 rile Transfer Protocol 

Host rUe Name 

Macintosh File 

Transfer Hode 

test ... 

prUile 

TeHt 

# of Bytes Transferred 902 

Messages 

Uploading In progress 

-----~- ---------------
- - -- - ---- - -

( Rbort transfer) 

.6. Important The "Transfer mode" field shows Text. If you want to transfer the file as a 
binary or MacBinary file, you must click the • Abort transfer" button and 
return to the File Transfer command in the Configure menu. If you choose 
the • Abort transfer- button, MacDFT leaves file transfer and returns to 
terminal emulation. 6. 
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figure 6-10 shows the file Transfer dialog box with the message that the file 
transfer is in progress. The dialog box also displays the number of bytes that 
have been transferred. 

• Figure ~10 File transfer in progress 

FT for MocOFT 1.0 

3270 File Tronster Protocol 

Host File Nome 

Macintosh rile 

Transfer Hode 
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TeHt 

# of Bytes Transferred 902 
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--- -------- - - - --=----~ 

( Rbort transfer) 
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Figure 6-11 shows the File Transfer dialog box when file transfer is complete. 
The file transfer dialog box messages tells the number of bytes that have 
been transferred and any informational or error messages. Error messages 
are listed in Appendix B. 

• FJgure 6-11 CoolpJeted flIe transfer 

---:::::---=-=~~ -=--= -----=-=--=--=-=--- - - ~ - --- FT for MacDFT 1.0 -=~..=---=--~ -~------

3270 rile Transfer Protocol 

Host file Name test.a 

Macintosh File prUile 

File Type Chosen TeHt 

1/ of Bytes Transferred 902 

Messages 

Uploading file completed successfully 

IBM Host @TSO OCMS 

Upload [Download] Done 

If you are finished transferring files, click Done. If you want to transfer 
another me, click Upload or Download. 
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Reading the Status Line 

T HE STATUS UNE AT TIlE 801TOM OF 11IE TERMINAl EMULATION scm., 
receives messages from the host and control unit. These messages tell the 

status of the host, control unit, and applications that you are running. 

This appendix shows some of the status line messages most frequently seen 

while using MacDfT, but does not cover all of the possible messages. IB~1 

documentation provides a comprehensive description of these messages and 

of problem resolution. If you do not understand status line messages, ask 

your system administrator for assistance. 

77 



The status line is displayed at the bottom of your Macintosh screen when 
your Macintosh is connected to a control unit. The status line displays 
Operator l1lformation Area (alA) messages about the host or control 
unit to which you are connected. This information appears as symbols, 
numbers, and letters. Figure A-I shows a MacDfT terminal emulation screen 
with alA messages in the status line . 

• Figure A-I MacDFf screen with OlA symbols 

••••••• • 
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•••• 
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••••••••••••••••••••••••••••••• 
•••••••••••••••••••••••••••••• 
•••••••••••••••••••••••••••• 
••••••••••••••••••••••••••• 
••••••••••••••••••••••••••• 
••••••••••••••••••••••••••• 
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•••••• •••••• 
Pre., EHTER key for ll,t of application. 

. ,: .. , ; ::; . . ~.,.' ; 

The symbols sent by the IBM host are shown in Table A-I. Status line 
messages are made up of one or more alA symbols that read from left to 
right. 
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• Table A·I OlA symbols 

Symbol 

f'i:"; .... 

I 

TEST 

Message 

Means do not enter (input inhibited) 

Means time is required 

Represents a display unh or printer 

Signifles a malfunc.tion 

Signifies a connection 

Signif1e5 that your Macintosh computer is connected to 
your application program 

Signifies that your Macintosh is connected to your system 
operator (conuol program) 

Signifies that your Macintosh is connected to the host 
system, but that your application program or control 
program is not connected 

Occurs when the TEST key is pressed, and indicates that 
the Macintosh is in TEST mode from the host 

The section that follows gives examples of status messages, classified by 
type. 

Readiness and system connect messages 

The readiness and system connection symbols are displayed in the first six 
character spaces in the status line. These symbols are used singly or in 
combinations to indicate the readiness of your Macintosh, control unit, or 
host. 
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Control unit ready symbols 

These symbols indicate that the control unit to which your Macintosh is 
connected is ready for operation. An S indicates that your Macintosh is 

connected to a 3174 oontrol unit. A 0ndicates that your Macintosh system 
is connected to a 3274 control unit. 

On·line symbols 

A Ready symbol must be displayed on your screen before an A or a ~(on-Iine 
symbols) can be displayed. These symbols tell you that the Macintosh is 
connected (on line) to the host. 

If your display is attached and on line to the control unit, the on-line symbol 
is displayed to tell you which of two sets of rules governs your transactions 
with the host. Certain keyboard functions and the meanings of some OIA 
symbols differ, depending on which set of rules is governing. A indicates that 
your Macintosh is attached to a control unit that is nOl running SNA, and .a 
indicates that your Macintosh is attached to a control unit that is running 
SNA. 

The on-line ~symbol turns off when you perform any action at your 
Macintosh that requires a response from the host system. When the host 
system responds, the a turns on again. Whether or not the off/on action is 
apparent depends on how busy the host system is and how quickly it 
responds. 

Do not enter messages 

Do not enter (input inhibited) 

The X ("do not enter") symbol tells you that your host will not accept input 
from your keyboard. Additional symbols are always displayed to the right of 
the X to define why your keyboard is inhibited. 

When the -do not enter" message appears, your host will nOl accept data 
from your keyboard. The reasons why the Mdo not enter" message comes on 
are discussed in the descriptions that follow. Each description also tells you . 
how to tum off the Mdo nOl enter" message and restore your keyboard. 
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Wait 

The host needs more time to perform the function you requested. You must 
wait for the function to be completed. 

Try It apJn 

Allor part of the last operation that you tried was ntt accepted by your 
Macintosh. Check your MacOFT window to make sure that the operation 
you want to perform is correct, press the RESET key to restore your 
keyboard, and try the operation again. Do not try to type while the X symbol 
is displayed. 

System lock 

The host has disabled your keyboard after processing your entry. The host 
may send you a message on your Macintosh, explaining the reason for 
disabling your keyboard. You can either wait for the host to restore your 
keyboard, or press the RESET key to restore your keyboard. You can access 
the RESET key from the keypad or the keyboard. 

Go elsewhere 

You have tried to take an action in the wrong location, such as 

• entering, inserting, erasing, or deleting a character when the cursor is in a 
protected field 

• performing a cursor-select operation when the cursor is not in a valid 
cursor-select field 

To restore your keyboard, press the RESET key, then move the cursor to 
anaber position or take a different action. 

Too much data 

You have entered more data into a field than it can hold. Press the RESET key 
to restore your keyboard; then correct the entry. 
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Numeric data only 

You have entered a nonnumeric character,other than 0 through 9, the DUP 
key, the period (.), and the minus sign (-), into a numeric field. Press the 
RESET key to restore your keyboard; then enter numeric data. 

Whatnumbcr? 

Only certain numbers can be entered for the operation you are performing. 
Press the RESET key to restore your keyboard; then enter the correct number. 

Minus function 

The function or operation that you requested is nOl available. Press the 
RESET key and check the OIA for other symbols to detennine if the function 
is permanently or temporarily unavailable. Here are some examples: 

• If either of these groups of symbols is displayed, the function is 
pennanently unavailable. Press the RESET key to restore your keyboard; 
then take other action. 

• If either of these groups of symbols is displayed, the CURSR SEL, A IT\, 
PA, and PF keys are inappropriate at this time. Press the RESET key to 
restore your keyboard, then take other action. 

• If this symbol is displayed and and none of the above symbol 
combinations is displayed, the function is temporarily unavailable. Press 
the RESET key to restore your keyboard, and try the function again. 
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Communication Check 

There is a problem with the communication line between the control unit and 
the host system. The error number nn or· nnn defines the type 
Communication Check. For example, the number 505 indicates that the 
control unit is not working. Press the RESET key to restore your keyboard, 
and try again. This message is in the rust six character positions in the status 
line. If you see these symbols in character position 21 of the status line, the 
message indicates a Communication Reminder message. See your system 
administrator if this message persists. 

Program Check 

The control unit detected a programming error in the data received from the 
host. The error number nn or nnn defines the type of Program Check. Press 
the RESET key to restore your keyboard, and continue. If the problem 
persiSts, consult your system administrator. 

Mode symbols 

MacDFT displays two mode symbols: 

• numeric lock 

• insert 

Numeric lock 

This symbol appears when you select Numeric Lock through the Display 
Settings command from the Configure Menu, and your cursor is in a host
defined numeric field. NUM appears in the center of your status line. 
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PP 

Insert 

This symbol appears when you select insert mode in your tenninal emulation 
session. The IBM keyboard has an Insert key that can be used from the 
Macintosh keyboard; see Chapter 5 to learn how to map IBM keys to the 
Macintosh keyboard. The Insert Key message is located in the center of your 
status line. 

MacDFT messages 

The Play and Play Pause messages appear on the status line during MacDFf 
sessions. 

Play 

P indicates that a recorded message is being sent to the host. Examples of 
situations that cause the P message to appear include an Autokey string, text 
that is being pasted into a host session, or a key from the Keypad. 

Play Pause 

PP indicates that the Autokey is pausing while sending a recorded message. 
Use the Resume key in the Autokey menu to continue playing the Autokey 
sequence. 
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MacDFf Error Messages 

ERROR MESSAGES COME FROM lIlE MACINTOSH COMPum, lIlE HOST, AND THE 

application that you are running. This appendix describes error messages that 

are generated by the MacDfT application. For information on messages from 

the Macintosh, or for general Macintosh troubleshooting information, see 

your Macintosh II owner's guide. For information on messages from the 

host, see your host documentation or your system administrator. Also, see 

Appendix A for status line messages from the host. 
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About MacDFT error messages 

MacDfT displays error messages in either an alert box or a warning box. The 
sections that follow contain strings of text that MacDfT displays in alert 
boxes. An alert box or warning can display one or more strings that explain the 
current situation and may suggest a solution. 

A1en boxes notify you whenever an usual situation occurs. Alert boxes 
inform yoo about choices yoo can make, given the situation. For severe 
problems, messages are placed in warning boxes . 

Figures B-1 and B-2 show examples of alert and warning boxes. Note that the 
a1en box contains a triangle surroonding an exclamation point (!), whereas the 
warning box contains the stop-sign octagon with a hand in the ·Stop!" 
position. 

The alert box in Figure B-1 lets you choose whether to install changes and 
reset the terminal. 

• Figure B-1 Alert box example 

To Inste .. the thenges. the 
terminal must be reset. Do 
you wish to proceed? 

No «Yes 11 

Figure B-2 shows a warning message. It informs you about a situation and 
forces you to acknowledge it by clicking the OK bunon. 
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Incorrect password 

Password is too long 

Password confinnation falled. 
Please try again 

Driver cannot be opened 

Host session cannot be 
established 

• Figure B-2 Warning message example 

There Is no 3270 adapter In 
your system. MatOFT cennot 
proceed. 

I OK I 

Password error messages 

Preproduction Draft 

You have typed your password incorrectly. Please try it again. See Chapter 3 
for more information about passwords. 

You have typed a password with too many characters. You can use up to 16 
characters for your password. See Chapter 3 for more information about 
passwords. 

You have typed your password incorrectly. Please try it again. See Chapter 3 
for more information about passwords. 

Hardware error messages 

Make sure that your application is installed correctly. See Chapter 2. 

Check with your system administrator if the host and control unit are on line. 
Make sure that your coaxial cable is attached to your Coaxlfwinax card. See 
Chapter 2 for information about how the cable should be attached. 
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There is no 3270 adapter in your 
system. MacOFI' cannot proceed 

please check the MacDFT User's 
Guide for the required 
configuration 

Duplicate or reserved keyboard 
equivalent 

A name may not begin with a 
space or contain characters 
"';1\</(" 

Please do not use the names of 
3270 control keys for your 
Autokey strings: they are reserved 

Too many resources 

MacDFI' configuration fLIes 
cannot be printed Use Open or 
New command in the File menu to 
open a configuration document 

You need a Coax!fwinax card to use MacDfT. If you have a card, make sure it 
is properly installed. See OIapter 2. 

Configuration error messages 

This message appears when you do not have the correct hardware and 
software to run MacDfT. See Chapter 1 -what You Need to Get Started.-

The Macintosh has assigned this key as a reserved keyboard equivalent. 
Choose another keyboard equivalent. 

An Autokey name cannot contain these characters. 

Do not use names like DUP, PFl, or PA2. These names are reserved. You can 
use the functionality of these keys through the keypad or the keyboard. 

You can have only 43 keypad menus. 

You cannot print configuration documents. If you want to see the 
information in your configuration document, use the Open command in the 
File menu to open a configuration document. 

Olrsor cannot be positioned here You have dicked or pointed outside of the space currently available to the 
because the default screen size terminal. Move your cursor. 
has been set by the host 
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Error writing file to host: FUe 
transfer canceled 

File transfer canceled 

Host timeout occurred 

Insufficient memory space 

Checksum error 

Closing local me error 

Creating local me error. 

Preproduction Draft 

Fne transfer error messages 

Try me transfer again. See Chapter 7 for more information on file transfer. If 
this problem persists, check with your system administrator. 

Try file transfer again. See Chapter 7 for more information on file transfer. If 
this problem persists, check with your system administrator. 

Try your command again or call your system administrator. If this problem 
persists, check with your system administrator. If you click OK, then press 
the Enter key, you may see a host-generated message explaining the timeout. 

There is not enough memory on your Macintosh. Oose other applications 
before using the File Transfer command. 

Cancel the File Transfer command, then try again. If this problem perSists, 
check with your system administrator, 

Cancel file transfer and try again. If this problem persists, check with your 
system administrator. 

Cancel file transfer and try again. If this problem persists, check with your 
system administrator. 
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Supported Environments 

M ACOff EMUlATES TIlE 3270 FAMILY OF mM ttRMINAl5. TI!IS A]>PE'IDIX 

lists terminals that MacDFT emulates, and supported hosts and control 

units. 
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Emulated terminals 

Table C-I lists IBM display tenninals that MacDFI' emulates . 

• Table (;1 Terminals that MacOFT emulates 

Terminal type 

3278 monochrome 

3279 Model 2 or 3 
Base and extended color 

3178 monochrome 

3179 Model 1, seven color 

Models numbers· 

2,3,4,5 

S2A, S2B, S3A, S3B 

C3 

2 

Each terminal has an 87-key typewriter keyboard a with numeric keypad, 

Supported host and control units 

MacDFr suppons IBM S/370 architecture machines, running MVSIXA, 
MVS/SP, or VM/SP. The Macintosh running MacDFr software can attach to 
the 3174 or 3274 control unit Category A devices. Table C-2 shows the 
supported control unit configuration for MacDFI'. 

• Table C-2 Control unit confIgUration 

Control unit 
model 

3174 
3274 
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Configuration 
support 

A 
D 

Microcode 
release 

2 or higher 
65 or higher 
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Glossary 

alert box: A type of dialog box that appears on the 
saeen when the user is in a crucial situation or is about 
to make a crucial decision. An alert box can warn of 
dangerous situations, recommend corrective actions, or 
provide information that might change the user's plans. 
See also dialog box. 

Apple Interprocess Communication (IPC) me: A 
process that communicates between the 
communication card and the MaCintosh 11. 

Autokey: A feature of MacDFT that lets the user create 
strings of text, or keystrokes, that the user can play in 
the same sequence by pressing an asSigned keyboard
equivalent key, or by choosing the Play command in the 
Autokey menu. 

button: A small screen object, usually labeled with text. 
Clicking a button performs the action described by the 
button'S label. 

check box: A special kind of button that indicates 
whether a certain option is on or off. The option is on 
if the box is checked, off if it is not. Check boxes 
appearing together in the same context are independent 
of each other; any number of boxes can be checked or 
unchecked. 

click: The action of pressing down the mouse button 
and quickly releasing it while the mouse remains 
stationary. 

coaxial cable: One type of medium used to connect a 
terminal to a control unit. 

coaxial connector: The pan of the Coox/fwinax card 
that connects to the coaxial cable. 

Preproduction Draft 

color wheel: A large on-screen item that appears when 
you click the Change Color button after selecting the 
Color icon in the Control Panel or Display Settings dialog 
box. By clicking on a portion of the color wheel, you can 
change the highlight color for your screen. See also Icon. 

Control Panel: A desk accessory that allows you to 
change certain basic characteristics of the Macintosh 
interface, such as the desktop panern, the volume level, 
and the key repeat rate. 

control unit: A peripheral node that can control a 
variety of devices. 

Control Unit Terminal (arr): A mode of IBM 
tenninal emulation that runs one session. 

dialog box: A window-like box that contains a 
message requesting more information from the user. 
Although dialog boxes appear in many different 
situations, they always appear when the user chooses a 
menu item that is followed, in the menu itself, by 
ellipses (...). 

dimmed: When words or icons appear in gray, they are 
dimmed. Menu items are dimmed when they cannot be 
chosen; folder icons are dimmed when they are open. See 
alsoJcon. 

Distributed Function Terminal (DFf): A mode of 
IBM tenninal emulation that runs up to five sessions. 

download: To transfer a file from the host to the 
Macintosh. 

drag: The action of placing the pointer on an object by 
using the mouse, pushing down the mouse bunon, 
moving the pointer to a new location on the screen, and 
releasing the mouse button. 
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uror message: A message displayed or printed to tell 
you of an error or problem in the execution of a program 
or in your communication with the system. An error 
message often appears in the form of an alert box, and is 
often accompanied by a beep. 

expansion card: A circuit board that implements 
specialized functions not otherwise supported by the 
computer. 

field: A subdivision of a record, usually consisting of a 
single item of information related to the rest of the 
rerord. 

host appDcation: An application that runs on the 
host computer. 

host computer: A multi-user computer, such as a 
minicomputer or mainframe, that serves as a central 
processing unit for a number of terminals. See also 
mainframe. 

IBM 3270 Infonnation Display System: See model 
2-S tenninaL 

icon: An image that graphically represents an object, a 
concept, or a message. Screen icons in mouse-based 
applications represent disks, documents, application 
programs, or other things you can select and open. 

launch: To put a program into action; to initiate a 
program. 

mainframe: A large computer, generally with a high 
level of processing power and the capacity to support 
many users at once. 

model 2-S tenninal: The different models of the IBM 
3270 Infonnation Display System. Each model 
displays a different configuration of rows and columns. 

MVS/TSO: An IBM host operating environment. 

NuBus: An address bus and data bus incorporated into 
the system architecture of the Macintosh II. The NuBus 
architecture lets you add a variety of components to the 
system, by means of expansion cards installed in NuBus 
expansion slots inside the Macintosh II. 

Glossary 
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Operator Infonnation Area (OlA): In the IBM 3270 
Information Display System, the area near the bouom 
of the display area where terminal or system status 
information is displayed in symbols. This area is also 
called the status Itne. See also IBM 3270 Infonnation 
Display System. 

parameter: A value passed to or from a function or 
aber routine. 

1Ct01I bar: A scroll bar is a light gray rectangle having on 
eam end an arrow in a square box. Vertical scroll bars are 
on the right side of the associated document, while 
horizontal scroll bars run along the bottom of the 
window. 

security lock mechanism: A lock-and-key mechanism 
on an IBM 3278 terminal that allows the user to prevent 
others from using it. 

select: To designate where the next action will take 
place. To select by using a mouse, you click an icon or 
drag acrC\Ss information. See also click, drag. 

session: A data "conversation- between two devices on 
a network. 

size box: The box in the lower-right corner of a 
window that the user can drag in order to enlarge or 
reduce the window. 

status nne: The line at the bottom of the MacDFT 
terminal emulation screen that displays OIA messages. 
See also Operator Infonnation Area (OlA). 

Systems Network Architecture (SNA): A set of 
communication protocols developed by IBM for 
transmission of data. A key purpose of SNA is to allow 
different types of terminals and devices to 
communicate over a network. 

tear-ofT menu: A menu that the user can "tear- from 
the menu bar and move around the screen like a window. 

terminal emulation: Software that allows a personal 
computer to communicate with a host computer by , 
transmitting in the form used by the host's terminals. 
See also host computer. 
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text box: A place in a dialog box in which you type text. 

trash can: An icon that initially appears in the lower
right comer of the desktop. You can remove files, 
folders, and applications from stol3ge media by 
dragging their icons into the trash can. 

upload: To transfer a me from the Macintosh to the 
host. 

OOCMS: An IBM host operating environment. 

Preproduction Draft 
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Ii APPLE COMPUTER, INC. 

This manual and the software described in it are copyrighted, with all rights reserved. 
Under the copyright laws, this manual or the software may not be copied, in whole 
or part, without written coosent of Apple, except in the normal use of the software or 
to make a backup copy of the software. The same proprietary and copyright notices 
must be affIXed to any permitted copies as were affIXed to the original. This 
exception does not allow copies to be made for others, whether or not sold, but all 
of the material purchased (with all backup copies) may be sold, given, or loaned to 
another person. Under the law, copying includes translating into another language 
or format. 

You may use the software on any computer owned by you, but extra copies cannot 
be made for this purpose. 

The Apple logo is a registered trademark of Apple Computer, Inc. Use of the 
"keyboard" Apple logo (Option-Shlft-K) for commercial purposes without the prior 
wriuen consent of Apple may constilute trademark infringement and unfair 
competition in violation of federal and state laws. 
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